
OVERVIEW

Welcome to SoftPaint.  Using SoftPaint should be intuitive.  Most of the menus and 
tools are standard items you have probably seen in several other programs already.  
The way these tools are used may be a little different, but those differences should 
be easy to understand.  If you do need help, this help window is available at any time.



File Menu

The File Menu
-------------------

   • New            ( Command N )
“New” will create a new window and allow you to start working on the new 
document.  If you run out of memory when attempting to create a new document, you 
will be alerted and the new document will not be created.

   • Open ...            ( Command O )
“Open” brings up a dialog box which will allow you to open a document from a file 
saved previously to disk.  As with New, if you run out of memory when attempting to 
open a document, you will be alerted and the document will not be opened.

   • Close            ( Command W )
“Close” will close the current window.  If it has not been saved since the last 
change, it will give you the opportunity to save the document before closing.

   • Save            ( Command S )
“Save” will save the current document to any disk.

   • Save As ...
“Save As” will bring up a dialog box which will allow you to save the current 
document under a new name.

   • Save as MacPaint ...
“Save as MacPaint” will bring up a dialog box which allow you to save the current 
document as a MacPaint document.

   • Revert
“Revert” allows you to quickly return to the last saved version of a document.

   • Document Size
“Document Size” is a hierarchichal menu which allows you to select between a 
Portrait (8 x 10) and a Landscape (10 x 8) page size.
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   • Page Setup ...
“Page Setup” allows you to set up the page alignment.  With the LaserWriter Page 
Setup allows you to scale the entire page.

   • Print ...            ( Command P )
Prints the current document.  High quality and standard quality are supported.  Draft 
quality is not supported (draft printing only works with text files).  The LaserWriter 
has a different sized page than the ImageWriter, so a section along the right side of 
the document will not be printed unless you select “96%” or less from “Page Setup.”

   • Print Selection ...
This will print the current selection.  The selection will be printed in the upper left 
corner of the page regardless of its location within the document.

   • Quit            ( Command Q )
Obviously.
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Edit Menu

The Edit Menu
-------------------

   • Undo            ( Command Z )
“Undo” is fully supported in SoftPaint.

   • Cut            ( Command X )
“Cut” will cut the selection from the window and place it in the clipboard.  You can 
then paste it into other programs (like MacPaint or SuperPaint) or into the scrapbook 
for later use.

   • Copy            ( Command C )
“Copy” will place a copy of the selection into the clipboard.  See Cut, above.

   • Paste            ( Command V )
“Paste” will place whatever graphic object is currently in the clipboard into your 
window.  The graphic will “hover” over the page until you click the mouse outside the 
selection box.  You can drag the selection box around the window to place it where 
you want it.  If the object is too big to fit in the window, you will see a message 
telling you that the object will be scaled to fit.  Scaling is always proportional to 
the original image.  To paste text into the document, you must have an active 
selection rectangle.  This is necessary to let the program know how wide a rectangle 
you want the text to fit into.

   • Clear
“Clear” will cut the area selected from the window, but will not place it in the 
clipboard.  It will be deleted from the page.  Pressing the delete key accomplishes 
the same thing.

   • Edit Patterns ...
“Edit Patterns” will bring up a dialog box in which you can edit any or all of the 64 
patterns.  These patterns will be saved off into the document, and will be available 
any time you open that document.  The patterns within the program will remain 
unchanged, and any new document will always be created with the default patterns 
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(those within the program).

   • Edit Brushes ...
“Edit Brushes” will bring up a dialog box in which you can edit any or all of the 36 
brushes.  Unlike the patterns, the brushes are not saved off into the document.  
Therefore, changing any brush will change the program, and new documents will be 
created with the new brushes.

   • Preferences
“Preferences” is a hierarchical menu which allows you to set various preferences 
within the program.  The first submenu, “Set Preferences” will bring up a dialog box 
which will let you set all preferences.  The second submenu, “Set Defaults from 
Current” takes the current values for all of the preferences and makes them the 
default settings.  The third submenu, “Set Current from Defaults” sets all of the 
current values to the default settings.   
   *** NOTE *** For more information on the various preferences, select 
“Preferences” from the list below.
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Options Menu

The Options Menu
-------------------

   • Invert Selection            ( Command I )
“Invert Selection” simply inverts the selected area.  Black areas will become white, 
and white areas will become black.

   • Flip Selection
“Flip Selection” is a hierarchical menu which will let you flip a selection 
Horizontally ( Command H ) or Vertically ( Command U ).  This only works for 
rectangular or oval shaped selections.

   • Rotate Selection
“Rotate Selection” is a hierarchical menu which will let you rotate a selection Right 
( Command R ) or Left ( Command L ).  This only works for rectangular or oval 
shaped selections.

   • Nudge
“Nudge” is a hierarchical menu which allows you to easily move the current 
selection one pixel in any direction.  This will not allow you to nudge a selection off 
the edge of the document.
   *** NOTE *** You can also use the arrow keys to nudge.

   • Scale Selection...            ( Command E )
“Scale Selection” will bring up a dialog box allowing you to scale the current 
selection by a percentage amount larger or smaller.  You may choose to have 
differenct scale factors for vertical and horizontal scaling.

   • Masking Tape
“Masking Tape” is a hierarchical menu which allows you to create, edit, or clear the 
current Mask region.  The first submenu, “Show Mask”/“Hide Mask” ( Command 4 ) 
toggles to allow you choose whether or not to view the current Mask region.  If you 
choose to view the current Mask, it will be outlined with a thick gray line.  The 
second submenu, “Mask Out” ( Command 5 ) will add the current selection to the 
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Mask region.  The third submenu, “Mask In” ( Command 6 ) will subtract the current 
selection from the Mask region.  The fourth submenu, “Reverse Mask” ( Command 7 ) 
will cause the areas inside the Mask region to be out of the region, and those areas 
that were previously outside the mask will now be inside the Mask region.  The last 
submenu, “Clear Mask” ( Command 8 ) will remove the Mask region.
   *** NOTE *** For more information on the Mask region, select Masking Tape from 
the list below.

   • Get Ink Mode...            ( Command G )
There are a total of eight ink modes that you can choose in SoftPaint.  This menu 
selection will present you with a dialog box that allows you to choose which mode 
you want.  Two small pictures are used to demonstrate the effect of the modes.  One 
picture is drawn on top of the other picture using the given ink mode.  Depending on 
the mode you select, any of a number of possible outcomes can occur and are 
displayed in the remaining box.

   • Display Page...            ( Command D )
This option will bring up a dialog box showing a reduced view of the entire page.  A 
rotating outline shows the current window position in relation to the page, and you 
can move the outline around to change the area of the page displayed in the main 
window.

   • Turn Autoscrolling On/Off
This menu item toggles allowing you to choose whether you want the tools to 
autoscroll or not.  With autoscrolling turned off, the paint tools will not draw 
outside of the window.

   • XY Coordinates
“XY Coordinates” is a hierarchical menu which allows you to select how you want the 
mouse position displayed.  In the lower part of the “Palette” there is an area where 
you can view the current mouse position.  Beside the “X” is the Abosolute X position.  
Beside the “∆” just below it is the Delta X position.  Below this are the Absolute and 
Delta Y positions.  The Absolute Mouse Position is relative to the upper left corner of 
the document.  Moving Right and Down are in the positive directions.  The Delta 
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Position is only shown when you click the mouse and drag it before letting up on the 
mouse button.  It is calculated by “subtracting” the original mouse position (where 
you clicked the mouse) from the current mouse position.  This allows you to make a 
rectangle, for example, which is exactly 100 x 100 pixels.  You can choose from 4 
possible displays: 1) Show Absolute Mouse Position, 2) Show “Delta” Mouse Position, 
3) Show Both Positions, 4) Don’t Show Positions.
   *** NOTE *** Having to continually update the mouse position may cause some of 
the tools to slow down.  If you find that the tools are not as fast as you would like, 
select “Don’t Show Positions” from the menu.
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Text Menu

The Text Menu
-------------------

   • Font
“Font” is a hierarchical menu which allows you to choose the current font.

   • Size
“Size” is a hierarchical menu which allows you to choose the current size.  You can 
choose from the following sizes: 9, 10, 12, 14, 18, 20, 24, 28, 36, 48, 54, 72.  Those 
sizes which are available in the current font appear outlined in the menu.

   • Style
“Style” is a hierarchical menu which allows you to choose the current style.  The 
available styles are: Plain Text, Bold, Italic, Underline, Outline, Shadow, Condensed, 
Extended.  Each style is displayed in its own style.  (For example, the Bold menu 
selection is displayed in bold text.)  A check mark shows beside each style which is 
currently selected.  Choosing “Plain Text” ( Command T ) cancels all other style 
selections.

   • Right Justify            ( Command 1 )
This selection will Right justify the text.

   • Center Justify            ( Command 2 )
This selection will Center justify the text.

   • Left Justify            ( Command 3 )
This selection will Left justify the text.



Windows Menu

The Windows Menu
-------------------

This menu lists the titles of the current windows which you have open.  Selecting an 
item from this menu will bring the window with that title to the front.



Masking Tape

Masking Tape
-------------------

The masking tape is used to “protect” certain areas of the document.  Drawing will 
not be performed in areas within the Mask region.  Areas outside the Mask will be 
drawn into.  This is analogous to putting “tape” around an area when you are painting. 
 This is useful, for instance, when you want to draw behind an object without 
affecting what is in front.

If you temporarily want to draw into the Mask region, but do not wish to clear the 
mask, you can hold down the Option key while drawing with any of the tools (except 
for the text tool).

*** NOTE *** For information on how create, edit, and clear the Mask region, select 
Options Menu from the list below, and read the text describing the “Masking Tape” 
hierarchical menu.



The Tool Palette



PopUp Menus



Clicks within the Palette

Clicks within the Palette
---------------------------

Single Clicking

  -- “Tools”
Clicking within any of the tools (Selection Tools, Text Tool, Paint Tools, or Shape 
Tools), selects the appropriate tool.  Clicking and holding the mouse in the Paint 
Brush tool displays a “Pop Up” Menu which allows you to select which brush to use.
  -- “Lines & Patterns”
Below the Shape Tools are the Line Size, Background Pattern, Line Pattern, and Fill 
Pattern areas.  Clicking in one of these 4 areas displays a “Pop Up” Menu which 
allows you to select the line width and various patterns.
  -- “XY Coordinate Area”
This area is used to give the Mouse Position.  Clicking here does nothing.

Double Clicking

Double clicking within certain tools has special significance.  Below is a list of each 
tool for which double clicking has significance and what a double click means in each.

  -- “Selection Rectangle”
Double clicking selects the entire window.  Holding the command key down while 
double clicking selects the entire page.
  -- “Selection Oval”
Double clicking creates the largest oval selection that will fit in the window.  
Holding the command key down while double clicking creates the largest oval 
selection that will fit in the page
  -- “Lasso”
Double clicking does a lasso selection of the entire window.  Holding the command 
key down while double clicking does a lasso selection of the entire page.
  -- “AirBrush”
Double clicking brings up a dialog box which allows you to change the various 
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airbrush settings.
  -- “Eraser”
Double clicking erases the entire window.  (Erasing means filling with the 
background pattern.)  Holding the command key down while double clicking erases the 
entire page.
  -- “Rounded Rectangle”
Double clicking brings up a dialog box which allows you to set the curvature of the 
Rounded Rectangles.  If you choose Circular Ends in the dialog box, the curvature will 
always be such that the smaller end of the rectangle will be completely curved (like 
an oval).  In this case, the scroll bar value has no meaning.  If you choose Corner 
Curvature, you may then use the scroll bar to set the amount of curvature.
  -- “Regular Polygon”
Double clicking brings up a dialog box which allows you to choose the number of 
sides (ranging from 3 to 12).
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Selection Tools

Selection Tools
------------------------

Selection tools allow you to select a part of the document.  The selection can then be 
moved, deleted, cut, or copied.  See the help for the Edit Menu for more information 
on Cut and Copy.  Once you have selected an area of the document, clicking outside 
the area will deselect the previous area and allow you to begin selecting another 
area.  Clicking within an active selection and then dragging with the mouse button 
held down will allow you to move the selection.  Pressing the delete key while a 
selection is active will delete the selection.

   • Selection Rectangle
This is the standard rectangle selection tool.  It draws a flashing “marquee” to 
identify the area of the screen you have selected.  If you hold the Command key down 
while selecting, the selection rectangle will shrink to the smallest rectangle which 
will include all of the black pixels in the original selection.  If you hold down the 
Option key while selecting, the selection will shrink to a “lasso selection” (see 
below).

   • Selection Oval
Essentially it is the same as the selection rectangle, but it is a lot more fun.  There 
are times that it is a handy little tool too.  Holding the Command key down does 
nothing.  However, if you hold the Option key while selecting, the selection will, just 
as with the Selection Rectangle, shrink to a “lasso selection” (see below).

   • Lasso
The Lasso Tool will allow you to select any irregularly shaped area of the document.  
Once you have let up on the mouse, the selection will automatically shrink to contain 
only the black pixels and the white pixels which are completely surrounded by black 
pixels.  If you hold the Option key down while selecting, the selection will not 
shrink, but will remain exactly as you selected.

••• Moving a selection
Once you have a selection, you can move it around as described above.  If you hold 
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down the Option key when you drag the selection, the selection will be “stamped” at 
its current location before you move it.  (In other words, it leaves a copy of the 
selection behind.)  If you hold down the Command key when you drag the selection, it 
turns the selection into a “brush”.  The selection will continually be “stamped” as 
you move it, leaving multiple copies behind.
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Text Tool

Text Tool
------------------------

The large letter "A" indicates text entry.  Selecting this tool turns the mouse into an 
“I-Beam” and when you click the mouse in the window, a flashing cursor appears.  
While the text is active you can use the mouse to move the text around the screen.  
To do so, click the mouse inside the active text rectangle (the cursor will look like a 
hand), and then drag the mouse.  If you hold the Option Key down as you drag the text, 
it will leave a copy of the text behind before it begins to move the text (like holding 
the Option Key down as you move a normal selection around).  As soon as you click 
the mouse outside of the active text area (where the cursor will again look like an 
“I-Beam”), the text is “impaled” into the document and becomes part of the bitmap.  
The Text Menu allows you to set the font, size, style, and justification of the text.



Paint Tools

Paint Tools
------------------------

Holding down the Option key while drawing with any of these tools allows you to 
draw into the Mask region.  See the information describing the Masking Tape for more 
information.

   • AirBrush
The AirBrush in SoftPaint is fully configurable.  Double-clicking on the AirBrush icon 
will bring up a dialog box that allows you to set several options.
   *** NOTE *** For more information on the AirBrush settings, select “AirBrush” 
from the list below.

   • Paint Brush
The paint brush draws the current brush shape using the currently selected fill 
pattern.  If you hold the Shift key down while drawing, the brush will be 
“constrained”.  This means that only a vertical or horizontal line will be drawn.
   *** NOTE *** To choose another paint brush, click the Paint Brush tool and hold 
the mouse down until the Pop up Menu appears.  While still holding down the mouse, 
select the desired paint brush.  You can edit the brushes by selecting “Edit Brushes 
...” from the Edit Menu.  When you edit the brushes, the changes are permanenly stored 
in the program.

   • FatBits
The magnifying glass icon allows you to select an area of the screen for expanding 
into fatbits.  The main window will then split into an expanded version of the area 
selected and a normal sized view.  The tools that are no longer supported will be 
disabled.  You can use the magnifying glass to select up to three layers of fatbits 
(2x, 4x, and 8x).  Once in fatbits, clicking the magnifying glass in the normal sized 
view area reduces magnification, while clicking in the fatbits view area increases 
magnification (up to the maximum expansion).  To go directly to fatbits (8x) you can 
hold the command key down and click anywhere in the page with the pencil tool.  
While in fatbits, holding the command key down and clicking the pencil tool in the 
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page will return you to normal operation.

   • Pencil
Operates like the pencil in most paint programs.  Clicking on a black pixel causes the 
pencil to draw in white until you let up on the mouse.  Clicking on a white pixel 
causes the pencil to draw in black.  If you hold the Shift key down while drawing, the 
pencil will be “constrained”.  This means that only a vertical or horizontal line will 
be drawn.

   • Paint Bucket
Operates like the standard paint bucket.  It fills an enclosed area with the fill 
pattern.  “Clipping” is a way to limit how far the Paint Bucket will fill.  The fill will 
be “clipped” to the window.  In fatbits, if you click in the normal size view area, it 
will be “clipped” to that rectangle.  Similarly, if you click in the fatbits view area, 
it will be “clipped” to that area of the document.  Holding the Command key down 
when you click the mouse will allow the fill to extend to the entire document, 
instead of being “clipped”.

   • Eraser
The eraser “fills” an area with the background pattern.  Usually the background 
pattern is white.  However, if you change the background pattern, don’t be surprised 
when the eraser no longer draws in white.  Holding the Command key down while 
using the eraser shrinks the eraser to one half its original size for more detailed 
work.  If you hold the Shift key down while drawing, the eraser will be 
“constrained”.  This means that only a vertical or horizontal line will be erased.  For 
information on how to erase an entire window or the entire document, select “Clicks 
within the Palette” from the list below.
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Shape Tools

Shape Tools
------------------------

Holding down the Option key while drawing with any of these tools allows you to 
draw into the Mask region.  See the information describing the Masking Tape for more 
information.

*** NOTE *** All of the shape tools operate similarly.  The “fill pattern” (the 
pattern that will fill the interior of the filled shapes) and the “line pattern” (the 
pattern that is used to draw the outside line of the shapes) are global.  In other 
words, whatever fill pattern you have currently selected is the same for all of the 
shapes.

*** NOTE *** All of the shape tools except the Line Tool and the Freeform Tool are 
divided into two halves in the Palette.  If you select the top half of the tool, an 
empty shape will be drawn. (The line will use the width you have currently selected 
and the line pattern you have currently selected, but the internal part of the shape 
will not be filled with any pattern.)  If you select the bottom half of the tool, a filled 
shape will be drawn.  (The same as the empty shape, except that the internal part of 
the shape will be filled with the currently selected fill pattern.)

   • Line Tool
Not much to this.  Click and drag the mouse and a line will be drawn.  If you hold 
down the Shift key while you are drawing the line, it will be “constrained”.  This 
means that only a horizontal, vertical, or diagonal (45° angle) line will be drawn.

   • Freeform Tool
This tool allows you to draw freeform shapes and have them filled with the selected 
fill pattern.

   • Rectangles
This tool is used to draw rectangles (obviously).  Holding the Shift key down while 
drawing will “constrain” the rectangle to a square.
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   • Ovals
This tool is used to draw ovals.  Holding the Shift key down while drawing will 
“constrain” the oval to a circle.

   • Rounded Rectangles
This tool is used to draw rectangles with rounded corners.  Holding the Shift key 
down while drawing will “constrain” the rectangle to a square.  Double clicking in 
the Rounded Rectangle icon will bring up a dialog box which will allow you to change 
the curvature of the corners.

   • Polygons
This tool allows you to create irregular polygons.  To draw polygons, click the mouse 
(then let up the mouse button) move the mouse to a new location (you will see a line 
follow you) and then click the mouse again.  Continue this until you have drawn a 
shape you like.  To finish the polygon, either double-click the mouse on the last area 
where you want a corner or click the mouse again on the original dot used to begin 
the polygon.  (The Delta X and Delta Y displays are very helpful here -- they will be 
0,0 when you are above the original point.)  If you have the filled version selected, it 
will fill with the pattern selected.

   • Arcs & Wedges
This tool is used to draw sections of ovals.  If you select the top half of the icon, an 
arc will be drawn.  If you select the lower half, the arc will be filled (resulting in a 
wedge shape).  Simply click and drag to draw the shape.  The resulting shape is 
always one quarter of an oval (90°).

   • Regular Polygons
This tool is used to draw regular polygons.  A regular polygon is one in which all 
sides and the same length and all angles are the same degree.  You can draw any 
shape from a regular triangle (equilateral) to a regular dodecagon (12 sides).  To 
select the number of sides you want, double click in the Regular Polygon icon.  A 
dialog box will appear, and you may select any number from 3 to 12.  Unlike the other 
shapes, this shape is drawn from the center and can rotate.  Click the mouse where 
you want the center of the shape to be.  While holding the mouse down, drag the 
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mouse to the radius you desire.  As you move the mouse around in a circular motion, 
the shape will rotate to follow you.  When you have the size and orientation you 
want, let up on the mouse.
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AirBrush
------------------------

The AirBrush in SoftPaint is fully configurable.  Double-clicking on the AirBrush icon 
will bring up a dialog box that allows you to set several options.  

Speed indicates the number of times paint will be sprayed on the screen in a given 
time.  

Flow indicates the number of dots that will be sprayed each cycle.  Size indicates 
the radius of the spray.  

Dot size allows you to spray dots of up to ten pixels instead of single dots.  

You also have the option to select between three types of Airbrushes (Normal, 
Symmetrical, Kaleidoscopic).  

You can choose between a random and a fixed dot size.  With random dot size, the 
dots will range from 1 pixel to the number you have choosen with the Dot Size scroll 
bar.  

You may also select between circular spray area and square spray area as well as 
between circular dots and square dots.



Fatbits

Fatbits
------------------------

The magnifying glass icon allows you to select an area of the screen for expanding 
into fatbits.  The main window will then split into an expanded version of the area 
selected and a normal sized view.  The tools that are no longer supported will be 
disabled.  You can use the magnifying glass to select up to three layers of fatbits 
(2x, 4x, and 8x).  Once in fatbits, clicking the magnifying glass in the normal sized 
view area reduces magnification, while clicking in the fatbits view area increases 
magnification (up to the maximum expansion).  To go directly to fatbits (8x) you can 
hold the command key down and click anywhere in the page with the pencil tool.  
While in fatbits, holding the command key down and clicking the pencil tool in the 
page will return you to normal operation.
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Keyboard Commands
------------------------

Holding down a modifier key (Command, Option, or Shift) affects the drawing of many 
of the tools.  There are also some other “keyboard shortcuts” which can come in 
handy.  Below is a description of how each modifier key affects each tool (if it does) 
as well as a description of any other keyboard commands.

••• Modifiers and Tools

   • Option Key
      - Selection Rectangle, Selection Oval
Holding the Option Key down when using these tools cause the selection to shrink to 
a “lasso selection.”
      - Lasso
Holding the Option Key down when using the lasso causes the selection to remain 
exactly as you drew it rather than “lasso-ing” the area within.
      - Paint Tools and Shape Tools (all other tools except the Text Tool)
Holding the Option Key down when drawing with any of these tools will allow you to 
draw into the Mask region without having to clear the Mask. ( *** NOTE *** For more 
information, selection Masking Tape from the list below )

   • Shift Key
The Shift Key is always used to “constrain” tools, as described below.
      - Selection Rectangle, Rectangle, Rounded Rectangle
Holding the Shift Key down when using these tools constrains the shape to a square.
      - Selection Oval, Oval, Arcs & Wedges
Holding the Shift Key down when using these tools constrains the shape to a circle.  
(For the Arcs & Wedges, the shape draw becomes a section of a circle rather than a 
section of an oval.)
      - Paint Brush, Pencil, Eraser
Holding the Shift Key down when using these tools constrains the drawing to a 
straight horizontal or vertical line.
      - Line Tool
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Holding the Shift Key down when using the Line Tool constrains the line to a 
horizontal, vertical or diagonal (45° angle) line.

   • Command Key
      - Selection Rectangle
Holding the Command Key down when using this tool will cause the selection to 
shrink to the smallest rectangle which will encompass all of the black pixels in the 
original selection area.
      - Paint Bucket
Holding the Command Key down when you click with the Paint Bucket will disable 
“Clipping”.  If you do not hold this key down, the fill performed will only fill areas of 
the current window, not the entire document.
      - Eraser
Holding the Command Key down when using the eraser will give you an eraser half of 
the original size.  This is useful for more detailed work.

••• Other “Keyboard Shortcuts”

   • 1) When using any tool, holding down the Space Bar will give you the “Grabbing 
Hand” cursor.  When you click and drag the mouse, the window will follow the cursor, 
allowing you to scroll without using the scroll bars.  This is especially useful when 
you are in fatbits (because there are no scroll bars in fatbits).

   • 2) Pressing the delete key when a selection is active will delete the selection.

   • 3) When a selection is active, you can use the arrow keys to “nudge” the 
selection rather than choosing from the menu.

   • 4) A quick way to get to the highest level of fatbits is to select the pencil tool 
and then to click in the window while holding down the Command Key.  The area of 
the screen where you click will be expanded into the fatbits view area.  Similarly, 
you can resume normal viewing by Command Clicking again (with the pencil).
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   • 5) Holding down the Option key when you drag a selection or when you drag an 
active text area will leave a copy of the selection behind before moving it.

   • 6) Holding down the Command key when you drag a selection will turn the 
selection into a brush, continually leaving a copy of the selection behind as you move 
it.
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Preferences
------------------------

There are various default settings (refered to as “Preferences”) which you can set 
within the program.  When you quit the program and then run it again, the settings 
will be whatever you set to be the defaults.

The following items may be set within the preferences dialog box:
• XY Coordinate System -- You may set the default to show the Absolute Coordinates 
only, the Delta Coordinates only, both, or neither.
• Open -- you may want the program to open with a window, with the open dialog 
box, or with an empty screen
• Autoscrolling -- enabled or disabled
• Brush -- choose the default Brush
• AirBrush -- choose the default AirBrush settings
• Regular Polygon -- choose the number of sides for the default Regular Polygon
• Page Setup -- set the default page size to Portrait (8 x 10) or Landscape (10 x 8)

*** NOTE *** For more information, select “Edit Menu” from the list below.



Limits

Limits
------------------------

SoftPaint requires about 500K of memory to run.  In Multifinder it is configured to 
use 600K of memory.  You can open windows until you run out of memory.  Cutting or 
pasting large selection areas can create out of memory condiditons.

You can change the memory size in Multifinder by selecting the SoftPaint icon in the 
Finder and choosing Get Info from the File Menu.  You can then increase the memory 
allowed for the program.  This will allow you to open more windows.
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LaserWriter Help
------------------------

Documents printed on the LaserWriter can take an unbelievable amount of time to 
print.  This is mostly due to  the graphic nature of a document.  Laser output is also 
not in alignment with ImageWriter output.  A standard printout of a document on the 
LaserWriter will cut off part of the border.  To avoid this, select 96% size in the 
Page Setup menu when printing to the LaserWriter.

The best results are obtained on the LaserWriter by selecting “4% reduction” and 
“larger print area.”  Be sure not to select bitmap smoothing, or you may see white 
lines in your printout.

When printing a landscape document in landscape format, be prepared for a lengthy 
wait.  [We used a LaserWriter Plus for this; perhaps the newer LaserWriters will 
work faster.]
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SoftPaint was written in Lightspeed Pascal by Sean Golden and Lynda Fowler.  

Kevin Cloud provided immeasurable help in beta-testing this program.  Other 
Beta-testers include: Tim Hoffmann, Pat Boozer, Barbara Schlichting, Naomi Johnson, 
Jacob Hirschfelt, Gary Knox, Diane Damm, Ed Thompson, Paul Drzaic, George Litterst, 
Dick Meyer, Catherine Sheehan, Ernest Sinclair, Peter Visel, Chris Wu, Paul Borzo, 
David Fisher, Dan Guerra, Owen Hartnett, Larry Pina, Jeff Billings, and Doug Olena.

Special thanks to Jeff Billings for his Paint Brush routines and to Apple® Computer 
for their BitmapToRegion routine.


